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NI USB-6008/6009
Périphérique DAQ USB multifonctions alimenté par bus
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ni.com/manuals

Les périphériques NI USB-6008/6009 sont dotés de huit voies d'entrée analogique (AI)
asymétriques, deux voies de sortie analogique (AO), 12 voies d'entrée/sortie numériques
(DIO) ainsi que d'un compteur 32 bits et d'une interface USB pleine vitesse. Ce guide de
l'utilisateur décrit comment utiliser ces périphériques.

Pour les spécifications, reportez-vous aux Spécifications du périphérique NI USB-6008 et aux
Spécifications du périphérique NI USB-6009 disponibles à partir de ni.com/manuals.

Le tableau suivant compare les périphériques NI USB-6008 et NI USB-6009.

Tableau 1. Comparaison entre le NI USB-6008 et le NI USB-6009

Fonctionnalité NI USB-6008 NI USB-6009

   Résolution AI 12 bits en mode
différentiel, 11 bits en
mode asymétrique

14 bits en mode différentiel, 13
bits en mode asymétrique

Fréquence d'échantillonnage
AI maximale, voie unique1

10 kÉch/s 48 kÉch/s

Fréquence d'échantillonnage
AI maximale, voies multiples
(ensemble)1

10 kÉch/s 48 kÉch/s

Configuration DIO Collecteur ouvert2 Chaque voie est programmable
individuellement en tant que
collecteur ouvert ou signal actif2

La figure suivante illustre les principaux composants fonctionnels des NI USB-6008/6009.

1 En fonction du système.
2 Ce document utilise les conventions de noms NI-DAQmx. 'Open-drain' est appelé collecteur

ouvert et 'push-pull' est appelé signal actif.
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Figure 1. Diagramme des périphériques NI USB-6008/6009
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Consignes de sécurité
La section suivante contient des informations de sécurité importantes que vous devez suivre
lors de l'installation et de l'utilisation des périphériques NI USB-6008/6009.

Attention  Utilisez les périphériques NI USB-6008/6009 uniquement comme décrit
dans les instructions d'utilisation. Une mauvaise utilisation du périphérique peut
s'avérer dangereuse. Si le périphérique est endommagé de quelque manière que ce
soit, cela peut compromettre la protection de sécurité intégrée dans le périphérique.
Si le périphérique est endommagé, contactez National Instruments pour le réparer.

Attention  Ne remplacez pas de pièces et ne modifiez pas le périphérique sauf si
vous suivez ce qui est décrit dans ce guide de l'utilisateur. Utilisez le périphérique
uniquement avec les accessoires spécifiés dans les instructions d'installation.
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Attention  N'utilisez pas le périphérique dans une atmosphère explosible ou dans
un environnement contenant des gaz ou des vapeurs inflammables. Si vous devez
faire fonctionner le périphérique dans un environnement de ce type, il doit se trouver
dans un boîtier conforme.

Règles de compatibilité électromagnétique
Ce produit a été testé et est conforme aux exigences et limites réglementaires relatives à la
compatibilité électromagnétique (CEM) indiquées dans les spécifications du produit. Ces
exigences et limites apportent une protection raisonnable contre les interférences dangereuses
lorsque le produit est utilisé dans l'environnement électromagnétique de fonctionnement pour
lequel il a été conçu.

Ce produit est conçu pour être utilisé sur des sites industriels. Cependant, des interférences
dangereuses peuvent survenir avec certaines installations, lorsque le produit est connecté à un
périphérique externe ou un objet de test, ou si le produit est utilisé dans des zones
résidentielles ou commerciales. Afin de minimiser les interférences radio et télévision et
d'éviter une dégradation inacceptable des performances, installez et utilisez ce produit
conformément aux instructions qui figurent dans la documentation qui l'accompagne.

Par ailleurs, toute modification apportée au produit et n'ayant pas été expressément approuvée
par National Instruments pourrait vous priver de votre droit d'utiliser le matériel
conformément aux règles locales applicables.

Attention  Pour garantir les performances CEM spécifiées, utilisez ce produit
uniquement avec des câbles et accessoires blindés.

Attention  Ce produit risque de devenir plus sensible aux perturbations
électromagnétiques dans son environnement de fonctionnement quand des fils de
test sont attachés ou quand il est connecté à un objet de test.

Attention  Des émissions excédant les exigences réglementaires risquent de se
produire lorsque ce produit est connecté à un objet de test.

Remarque  Toute modification apportée au produit et n'ayant pas été expressément
approuvée par National Instruments pourrait vous priver de votre droit d'utiliser le
matériel conformément aux règles locales applicables.

Déballage du kit
Attention  Pour éviter que des décharges électrostatiques n'endommagent le
périphérique, reliez-vous à la masse avec un bracelet de mise à la terre ou en
touchant un objet mis à la masse, tel que le châssis de votre ordinateur.

1. Mettez l'emballage antistatique en contact avec une partie métallique du châssis de
l'ordinateur.
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2. Sortez le périphérique de son emballage et examinez-le pour repérer tout composant
déconnecté ou tout autre signe d'endommagement.

Attention  Ne touchez jamais les broches exposées des connecteurs.

Remarque  N'installez pas un périphérique s'il semble endommagé de quelque
façon que ce soit.

3. Déballez tout autre élément et documentation du kit.

Conservez le périphérique dans son emballage antistatique lorsque vous ne l'utilisez pas.

Configuration des périphériques
NI USB-6008/6009
Effectuez les étapes suivantes pour démarrer avec les périphériques NI USB-6008/6009.

Remarque  Pour obtenir des informations relatives au support des systèmes
d'exploitation autres que Windows, reportez-vous au document Getting Started with
NI-DAQmx Base, disponible sur ni.com/manuals.

1. Installez le logiciel d'application (le cas échéant), en suivant les instructions d'installation
fournies avec le logiciel.

2. Installez NI-DAQmx3.

Remarque  Le logiciel NI-DAQmx est inclus sur le disque livré avec votre kit
et disponible pour téléchargement sur ni.com/support. La documentation
du logiciel NI-DAQmx est disponible après installation, à partir de Démarrer»
Tous les programmes»National Instruments»NI-DAQmx. De la
documentation supplémentaire est disponible sur ni.com/manuals.

3. Installez les connecteurs de type bornier à vis à 16 contacts en les insérant dans les jack
de connexion, comme l'indique la figure suivante.

3 Les périphériques NI USB-6008/6009 sont supportés par NI-DAQmx 7.5 et versions ultérieures
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Figure 2. Diagramme d'application des étiquettes de signaux
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des contacts
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3. Étiquette de signaux
4. Câble USB

4. Collez les étiquettes de signaux fournies sur les connecteurs de type bornier à vis. Vous
pouvez choisir des étiquettes ayant des numéros de broches, des noms de signaux ou des
étiquettes vierges, comme l'indique la figure suivante. Choisissez l'étiquette qui convient,
alignez-la avec les terminaux imprimés sur la face supérieure de votre périphérique puis
appliquez l'étiquette, comme le montre la figure précédente.

Figure 3. Étiquettes de signaux des périphériques NI USB-6008/6009
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1. Étiquette personnalisée définie par l'utilisateur
2. Étiquette des numéros de terminaux
3. Étiquette d'E/S numériques

4. Étiquette des nom de signaux d'entrée analogique
différentiels

5. Étiquette des noms de signaux d'entrée
analogique asymétriques

Remarque  Une fois que vous avez étiqueté les connecteurs de type bornier à
vis, vous ne devez les insérer que dans les jack de connexion correspondants,
comme l'indique l'étiquette située sur la face supérieure du périphérique.

5. Branchez l'une des extrémités du câble USB au NI USB-6008/6009 et l'autre extrémité à
un port USB disponible sur votre ordinateur.
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6. Double-cliquez sur l'icône NI MAX située sur le bureau pour ouvrir Measurement &
Automation Explorer (MAX).

7. Développez Système»Périphériques et interfaces et vérifiez que le NI USB-6008/6009
est listé. Si votre périphérique n'apparaît pas, appuyez sur la touche <F5> pour rafraîchir
l'affichage dans MAX. Si votre périphérique n'est toujours pas reconnu, reportez-vous à
ni.com/support/daqmx pour obtenir des informations de dépannage.

8. Effectuez un auto-test de votre périphérique dans MAX en cliquant avec le bouton droit
sur NI USB-6008 ou NI USB-6009, puis en sélectionnant Auto-test. L'auto-test effectue
un test rapide pour confirmer que le périphérique est correctement installé. Au terme de
l'auto-test, un message s'affiche, indiquant si la vérification s'est déroulée sans problème
ou si une erreur a eu lieu. Si une erreur s'est produite, reportez-vous à ni.com/
support/daqmx.

Attention  Pour garantir les performances CEM spécifiées, utilisez ce produit
uniquement avec des câbles et accessoires blindés.

9. Connectez les fils (16 AWG à 28 AWG) d'un câble blindé, multiconducteur aux borniers
à vis en enlevant l'isolation sur une longueur de 6,35 mm (0,25 pouces), en insérant les
fils dans les borniers à vis, puis en ressérant fermement les vis à un couple de
0,22 N · m à 0,25 N · m (2,0 à 2,2 livres-pouces) avec un tournevis à lame plate.
Reportez-vous à la section Description du brochage et des signaux pour obtenir un
schéma de brochage des périphériques NI USB-6008/6009.

Si vous utilisez un câble blindé, connectez le blindage du câble à un terminal GND à
proximité.

Remarque  Pour obtenir des informations sur les capteurs, reportez-vous à
ni.com/sensors. Pour en savoir plus sur les capteurs intelligents TEDS
IEEE 1451.4, reportez-vous à ni.com/teds.

10. Lancez un panneau de test dans MAX en cliquant avec le bouton droit sur NI USB-6008
ou NI USB-6009, puis en sélectionnant Panneaux de test.

Cliquez sur Démarrer pour tester les fonctions du périphérique ou sur Aide pour obtenir
des instructions d'utilisation. Cliquez sur Fermer pour quitter les panneaux de test.

Utilisation des NI USB-6008/6009 dans une
application
Vous pouvez utiliser l'Assistant DAQ depuis de nombreux programmes logiciels d'application
de NI afin de configurer des voies virtuelles et de mesure. Le tableau suivant indique
l'emplacement du tutoriel de l'Assistant DAQ pour diverses applications NI.
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Tableau 2. Emplacement du tutoriel de l'Assistant DAQ

Application NI Emplacement du tutoriel

  LabVIEW Sélectionnez Aide»Aide LabVIEW. Ensuite, sélectionnez
Initiation à LabVIEW»Initiation à DAQ»Prendre une mesure
NI-DAQmx dans LabVIEW.

LabWindows™/CVI™ Sélectionnez Help»Contents. Ensuite, sélectionnez Using
LabWindows/CVI»Data Acquisition»Taking an NI-DAQmx
Measurement in LabWindows/CVI.

Measurement Studio Sélectionnez NI Measurement Studio Help»Getting Started
with the Measurement Studio Class Libraries»Measurement
Studio Walkthroughs»Walkthrough: Creating a
Measurement Studio NI-DAQmx Application.

LabVIEW SignalExpress Sélectionnez Aide»Prendre une mesure NI-DAQmx dans
SignalExpress.

Reportez-vous à la section Et maintenant ? pour obtenir des informations relatives aux
exemples de programmation pour NI-DAQmx et NI-DAQmx Base.

Fonctionnalités
Les périphériques NI USB-6008/6009 disposent d'un connecteur USB, de maintien de câble
USB, de deux connecteurs de type bornier à vis pour les E/S ainsi que d'un indicateur LED,
comme l'indique la figure suivante.
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Figure 4. Vues du haut et de l'arrière des périphériques NI USB-6008/6009
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Connecteur USB et maintien de câble USB
Les périphériques NI USB-6008/6009 disposent d'un connecteur USB pour une interface USB
pleine vitesse. Vous pouvez maintenir le câble USB en enfilant une attache dans la bague de
maintien du câble puis en ressérant autour un câble USB en forme de boucle, comme l'indique
la figure suivante.

Figure 5. Maintien des périphériques NI USB-6008/6009

1

Indicateur LED
Les périphériques NI USB-6008/6009 disposent d'un indicateur LED vert qui indique l'état du
périphérique, comme le montre le tableau suivant. Lorsque le périphérique est connecté à un
port USB, la LED clignote pour indiquer que le périphérique est initialisé et alimenté par la
connexion.
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Tableau 3. Statut de la LED et du périphérique

Statut de la LED Statut du périphérique

  Non allumée Périphérique non connecté ou arrêté

Allumée, ne clignote pas Périphérique connecté mais non initialisé, ou ordinateur en mode
veille. Pour que le périphérique soit reconnu, il doit être connecté
à un ordinateur ayant NI-DAQmx installé.

Clignote une fois Fonctionne normalement

Connecteurs de type bornier à vis
Les NI USB-6008/6009 sont livrés avec un connecteur amovible de type bornier à vis pour les
signaux analogiques et un pour les signaux numériques. Ces connecteurs de type bornier à vis
offrent 16 connexions qui utilisent des fils 16–28 AWG. Reportez-vous à l'étape 4 de la section 
Configuration des périphériques NI USB-6008/6009 pour obtenir des informations relatives au
choix de l'étiquette pour les connecteurs de type bornier à vis. Reportez-vous à la section 
Description du brochage et des signaux pour obtenir la description du brochage des
périphériques et des signaux.

Vous pouvez commander des connecteurs et étiquettes supplémentaires pour votre
périphérique. Reportez-vous à la section Câbles et accessoires pour obtenir des informations
afin de passer commande.

Firmware
Le firmware des NI USB-6008/6009 se rafraîchit dès que les périphériques sont connectés à un
ordinateur doté de NI-DAQmx. NI-DAQmx charge automatiquement la version du firmware
compatible avec le périphérique. La version du firmware peut être mise à niveau quand une
nouvelle version de NI-DAQmx est publiée.

Câbles et accessoires
Le tableau suivant contient des informations concernant les câbles et accessoires disponibles
pour les périphériques NI USB-6008/6009. Pour obtenir une liste complète des accessoires
ainsi que des informations pour passer commande, reportez-vous à la section Prix de la page
produit du NI USB-6008 ou du NI USB-6009 sur ni.com.
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Tableau 4. Câbles et accessoires des périphériques NI USB-6008/6009

Accessoire Référence Description

   Kit d'accessoires USB
6008/6009

779371-01 Quatre connecteurs de type bornier à vis
supplémentaires, des étiquettes de
connecteurs et un tournevis

Accessoire de
prototypage de la série
USB-6000

779511-01 Accessoire non blindé de prototypage pour
le conditionnement de signal et le
prototypage personnalisés. Vous pouvez
utiliser jusqu'à deux accessoires par
périphérique.

Câble USB haute vitesse 184125-01,
184125-02

1 m et 2 m de long

Attention  Pour assurer la conformité aux exigences de compatibilité
électromagnétique (CEM), ce produit doit être connecté par des câbles et des
accessoires blindés. Si des câbles ou des accessoires non blindés sont utilisés, les
spécifications CEM ne sont plus garanties, sauf si tous les câbles et/ou accessoires
non blindés sont installés dans une enceinte blindée dotée de ports d'entrée/sortie
blindés correctement conçus.

Description du brochage et des signaux
La figure suivante illustre le brochage des périphériques NI USB-6008/6009. Les noms de
signaux d'entrée analogique sont répertoriés comme noms d'entrée analogique (AI)
asymétrique, AI x, suivis du nom de l'entrée analogique différentielle, (AI x+/-). Reportez-vous
au tableau suivant pour trouver la description détaillée de chaque signal :

10 | ni.com | NI USB-6008/6009 Guide de l'utilisateur



Figure 6. Brochage des périphériques NI USB-6008/6009
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Tableau 5. Description des signaux

Nom du
signal

Référence Direction Description

    GND — — Masse — Le point de référence pour les mesures
d'entrée analogique asymétriques, les tensions de
sortie analogique, les signaux numériques,
l'alimentation de + 5 VCC et de + 2,5 VCC au
connecteur d'E/S, et le point de retour des courants
de polarisation pour les mesures différentielles.

AI <0..7> Varie Entrée Voies d'entrée analogique 0 à 7 — Pour les
mesures asymétriques référencées, chaque signal est
une voie de tension d'entrée analogique. Pour les
mesures différentielles, AI 0 et AI 4 sont les entrées
positive et négative de la voie d'entrée analogique
différentielle 0. Les paires de signaux suivantes
forment également des voies d'entrée
différentielles : AI <1, 5>, AI <2, 6> et AI <3, 7>.
Reportez-vous à la section Entrée analogique pour
obtenir de plus amples informations.
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Tableau 5. Description des signaux (suite)

Nom du
signal

Référence Direction Description

    AO <0, 1> GND Sortie Voies de sortie analogique 0 à 1 — Fournit la
sortie de tension de la voie de sortie analogique 0 ou
1. Reportez-vous à la section Sortie analogique
pour obtenir de plus amples informations.

P0.<0..7> GND Entrée ou
sortie

Port 0, voies d'E/S numériques 0 à 7— Vous
pouvez configurer individuellement chaque signal
comme entrée ou sortie. Reportez-vous à la section 
E/S numériques pour obtenir de plus amples
informations.

P1.<0..3> GND Entrée ou
sortie

Port 1, voies d'E/S numériques 0 à 3 — Vous
pouvez configurer individuellement chaque signal
comme entrée ou sortie. Reportez-vous à la section 
E/S numériques pour obtenir de plus amples
informations.

PFI 0 GND Entrée PFI 0  — Cette broche est configurable comme
déclenchement numérique ou comme entrée de
compteur d'événements. Reportez-vous à la section 
PFI 0 pour obtenir de plus amples informations.

+2,5 V GND Sortie Référence externe +2,5 V — Fournit une référence
pour du test par rebouclage. Reportez-vous à la
section Référence externe +2,5 V pour obtenir de
plus amples informations.

+5 V GND Sortie Source d'alimentation +5 V— Fournit une
alimentation de +5 V jusqu'à 200 mA. Reportez-
vous à la section Source d'alimentation +5 V pour
obtenir de plus amples informations.

Entrée analogique
Les périphériques NI USB-6008/6009 disposent de huit voies d'entrée analogique que vous
pouvez utiliser pour effectuer quatre mesures d'entrée analogique différentielles ou huit
mesures d'entrée analogique asymétriques.

La figure suivante illustre le circuit d'entrée analogique des périphériques NI USB-6008/6009.
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Figure 7. Circuit d'entrée analogique des périphériques NI USB-6008/6009
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Les principaux blocs qui composent le circuit d'entrée analogique des périphériques
NI USB-6008/6009 sont les suivants :
• MUX — Les périphériques NI USB-6008/6009 disposent d'un convertisseur analogique/

numérique (C A/N). Le multiplexeur (MUX) assure le routage d'une voie AI à la fois vers
le PGA.

• PGA — L'amplificateur de gain programmable fournit des gains d'entrée de 1, 2, 4, 5, 8,
10, 16 ou 20 lorsqu'il est configuré pour effectuer des mesures différentielles et un gain
de 1 lorsqu'il est configuré pour des mesures asymétriques. Le gain PGA est
automatiquement calculé sur la base de la gamme de tension sélectionnée dans
l'application de mesure.

• C A/N — Le convertisseur analogique/numérique (C A/N) numérise le signal AI en
convertissant la tension analogique en code numérique.

• AI FIFO — Les périphériques NI USB-6008/6009 peuvent effectuer des conversions
analogiques/numériques simples et multiples d'un nombre fixe ou infini d'échantillons.
Un buffer FIFO (First-In-First-Out) contient les données durant les acquisitions AI pour
assurer qu'aucune donnée n'est perdue.

Modes d'entrée analogique et sources de signaux
Vous pouvez configurer les voies AI des périphériques NI USB-6008/6009 pour effectuer des
mesures différentielles ou asymétriques référencées (RSE). Le tableau suivant résume les
modes d'entrée analogique recommandés pour les sources de signaux flottantes et les sources
référencées à la masse. Reportez vous à la section Description du brochage et des signaux afin
d'obtenir des informations complémentaires sur la configuration des E/S pour des mesures
asymétriques ou différentielles.
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Tableau 6. Configuration de l'entrée analogique

Mode d'entrée
analogique

Sources de signaux flottantes
(non connectées à la terre du

bâtiment)

Sources de signaux référencées à
la masse

   Exemples • Thermocouples non mis à la
masse

• Conditionnement de signal
avec sorties isolées

• Appareils alimentés par piles

Appareils alimentés par piles avec
sorties non isolées

Différentielle
(DIFF)

+
–

+

–

AI+ 

AI– 

GND

Source de signal NI USB-6008/6009

+
–

+

–

AI+ 

AI– 

GND

Source de signal NI USB-6008/6009

Asymétrique
référencée à la
masse (RSE) +

–

+

–

AI 

GND

Source de signal NI USB-6008/6009

La tension de boucle de mise à la masse
(TA – TB) est ajoutée au signal mesuré.

NON RECOMMANDÉ

+
–

+

–

AI 

GND
TB

TA

Source de signal NI USB-6008/6009

Sources de signaux flottantes
Une source de signal flottante n'est pas connectée à la terre du bâtiment, mais dispose d'un
point de référence à la masse isolé. Quelques exemples de sources de signaux flottantes sont
les sorties de transformateurs, les thermocouples, les appareils alimentés par piles, les
isolateurs optiques et les amplificateurs d'isolement. Un instrument ou un périphérique qui
possède une sortie isolée est une source de signal flottante.

Pour plus d'informations, reportez-vous au document Field Wiring and Noise Considerations
for Analog Signals. Pour accédez à ce document, allez sur ni.com/frinfo et entrez l'info-
code rdfwn3.
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À quel moment utiliser des connexions différentielles avec des sources de
signaux flottantes ?
Utilisez des connexions d'entrée DIFF pour toute voie répondant à l'une des conditions
suivantes :
• Votre application nécessite des gammes d'entrée autres que ±10 V.
• Le signal en entrée est faible et nécessite une plus grande précision.
• Les fils conducteurs connectant le signal au périphérique sont supérieurs à 3 m (10 pieds).
• Le signal en entrée nécessite un point de référence à la masse ou un signal renvoyé

séparé.
• Les fils conducteurs des signaux passent dans des environnements bruyants.
• Deux voies analogiques, AI+ et AI-, sont disponibles pour le signal.

Les connexions de signaux DIFF réduisent le bruit capté et augmentent la réjection du bruit de
mode commun. Les connexions de signaux DIFF permettent également aux signaux d'entrée
de flotter dans la tension de fonctionnement du périphérique.

Reportez-vous à la section Prise de mesures différentielles pour obtenir de plus amples
informations sur les connexions différentielles.

À quel moment utiliser des connexions asymétriques référencées (RSE) avec
des sources de signaux flottantes ?
N'utilisez des connexions d'entrée RSE que si le signal en entrée répond aux conditions
suivantes :
• Le signal en entrée peut partager un point de référence commun, GND, avec d'autres

signaux utilisant le mode RSE.
• Votre application permet l'utilisation de la gamme d'entrée ±10 V.
• Les fils conducteurs connectant le signal au périphérique sont inférieurs à 3 m (10 pieds).

Les connexions d'entrée DIFF sont recommandées afin de maximiser l'intégrité du signal pour
tout signal d'entrée ne répondant pas aux conditions ci-dessus.

Dans les modes asymétriques, davantage de bruit électrostatique et magnétique s'ajoute aux
connexions de signaux que dans des configurations DIFF. Le couplage est le résultat de
différences dans le chemin du signal. Le couplage magnétique est proportionnel à la zone entre
les deux conducteurs de signaux. Le couplage électrique est fonction de la différence de champ
électrique existant entre les deux conducteurs.

Avec ce type de connexion, le PGA rejette aussi bien le bruit de mode commun dans le signal
que la différence potentielle de masse entre la source du signal et la masse du périphérique.

Reportez-vous à la section Prise de mesures asymétriques référencées pour en savoir plus sur
les connexions RSE.
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Sources de signaux référencées à la masse
Une source de signal référencée à la masse est une source connectée à la terre d'un bâtiment.
Elle est déjà connectée au même point de masse que le périphérique, en supposant que
l'ordinateur soit branché au même système d'alimentation que la source. Les sorties non isolées
d'instruments et de périphériques, qui se branchent au système d'alimentation d'un bâtiment,
font partie de cette catégorie.

La différence de potentiel de masse entre deux instruments connectés au même système
d'alimentation d'un bâtiment est généralement comprise entre 1 mV et 100 mV, mais elle peut
être bien plus élevée si les circuits de distribution d'alimentation sont incorrectement
connectés. Si une source de signal mise à la masse n'est pas mesurée correctement, la
différence peut causer une erreur de mesure. Veuillez suivre les instructions de connexion pour
les sources de signaux mises à la masse afin d'éliminer cette différence potentielle de masse du
signal mesuré.

Pour plus d'informations, reportez-vous au document Field Wiring and Noise Considerations
for Analog Signals. Pour accédez à ce document, allez sur ni.com/frinfo et entrez l'info-
code rdfwn3.

À quel moment utiliser des connexions différentielles avec des sources de
signaux référencées à la masse ?
Utilisez des connexions d'entrée DIFF pour toute voie répondant à l'une des conditions
suivantes :
• Votre application nécessite des gammes d'entrée autres que ±10 V.
• Le signal en entrée est faible et nécessite une plus grande précision.
• Les fils conducteurs connectant le signal au périphérique sont supérieurs à 3 m (10 pieds).
• Le signal en entrée nécessite un point de référence à la masse ou un signal renvoyé

séparé.
• Les fils conducteurs des signaux passent dans des environnements bruyants.
• Deux voies analogiques, AI+ et AI-, sont disponibles pour le signal.

Les connexions de signaux DIFF réduisent le bruit capté et augmentent la réjection du bruit de
mode commun. Les connexions de signaux DIFF permettent également aux signaux d'entrée
de flotter dans la tension de fonctionnement du périphérique.

Reportez-vous à la section Prise de mesures différentielles pour obtenir de plus amples
informations sur les connexions différentielles.

À quel moment utiliser des connexions asymétriques référencées (RSE) avec
des sources de signaux référencées à la masse ?
N'utilisez pas de connexions RSE avec des sources de signaux référencées à la masse. Utilisez
plutôt des connexions différentielles.
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Comme l'indique le tableau de la section Modes d'entrée analogique et sources de signaux,
une différence potentielle entre GND et la masse du capteur peut exister. En mode RSE, cette
boucle de mise à la masse provoque des erreurs de mesure.

Prise de mesures différentielles
Pour les signaux différentiels, connectez le fil conducteur positif du signal au terminal AI+ et
le fil conducteur négatif au terminal AI-.

Figure 8. Connexion d'un signal de tension différentiel

AI+

NI USB-6008/6009

AI–

Source
de 
tension

Le mode d'entrée différentiel peut mesurer des signaux de ±20 V dans la gamme de ±20 V.
Cependant, la tension maximale de n'importe quelle broche est de ±10 V par rapport à GND.
Par exemple, si AI 1 est de +10 V et AI 5 de -10 V, la mesure renvoyée par le périphérique est
donc de +20 V.

Figure 9. Exemple d'une mesure différentielle de 20 V
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La connexion d'un signal supérieur à ±10 V sur l'une des broches entraîne une sortie écrêtée.
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Figure 10. Excéder ±10 V sur une AI renvoie une sortie écrêtée

–5

–10

–15

–20

20

15

10

5

0

A
m

pl
itu

de
 (

V
)

AI 1

AI 5

Résultat

Prise de mesures asymétriques référencées
Pour connecter des signaux de tension asymétriques référencés (RSE) aux périphériques
NI USB-6008/6009, connectez le signal de tension positif à un terminal AI et le signal mis à la
masse à un terminal GND, comme l'indique la figure siuivante.

Figure 11. Connexion d'un signal de tension asymétrique référencé
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Source
de

tension

Lorsqu'aucun signal n'est connecté au terminal d'entrée analogique, le diviseur de résistance
interne peut entraîner le terminal à flotter à approximativement 1,4 V quand le terminal
d'entrée analogique est configuré en mode RSE. Ce comportement est normal et n'affecte pas
la mesure quand un signal est connecté.

Déclenchement numérique
Vous pouvez configurer PFI 0 comme entrée de déclenchement numérique pour des tâches
d'entrée analogique. Reportez-vous à la section Utilisation de PFI 0 comme déclenchement
numérique pour obtenir des informations complémentaires.

Sortie analogique
Les périphériques NI USB-6008/6009 disposent de deux voies de sortie analogique
indépendantes qui peuvent générer des tensions de sortie comprises entre 0 V et 5 V. Toutes
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les mises à jour de voies de sortie analogique sont cadencées par logiciel. GND est le signal de
référence à la masse pour les voies de sortie analogique.

La figure suivante montre le circuit d'une voie de sortie analogique sur les NI USB-6008/6009

Figure 12. Circuit d'une voie de sortie analogique

REF(+) REF(–)
C N/A
12 bits

50 Ω
AO

+5 V

GND

Le principal bloc qui compose le circuit de sortie analogique des périphériques
NI USB-6008/6009 est le convertisseur numérique/analogique (C N/A), qui convertit des
codes numériques en tensions analogiques. Il existe un C N/A pour chaque ligne de sortie
analogique.

Connexion de charges de sortie analogique
Pour connecter des charges aux périphériques NI USB-6008/6009, connectez le fil conducteur
positif de la charge au terminal AO et connectez la masse de la charge à un terminal GND,
comme l'indique la figure suivante.

Figure 13. Connexion d'une charge

NI USB-6008/6009

GND

AO

Charge

Minimisation des impulsions transitoires sur le signal
de sortie
Lors de l'utilisation d'un C N/A pour générer un signal, il est possible d'observer des
impulsions transitoires sur le signal de sortie. Ces impulsions transitoires sont normales ;
quand un C N/A passe d'une tension à une autre, il produit des impulsions transitoires dues à la
libération de charges. Les impulsions transitoires les plus importantes se produisent quand le
bit de poids fort du code du C N/A change. Vous pouvez construire un filtre passe-bas afin de
supprimer certaines impulsions transitoires, selon la fréquence et la nature du signal en sortie.
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Pour en savoir plus sur la minimisation des impulsions transitoires, reportez-vous au document
de la Base de connaissances Reducing Glitches on the Analog Output of MIO DAQ Devices.
Pour accédez à ce document, allez sur ni.com/frinfo et entrez l'info-code exszek.

E/S numériques
Les périphériques NI USB-6008/6009 disposent de 12 lignes numériques sur deux ports. Le
Port 0 possède huit lignes, P0.<0..7>, et le Port 1 en possède 4, P1.<0..3>. GND est le signal
référencé à la masse pour les ports d'E/S numériques. Vous pouvez programmer
individuellement toutes les lignes comme entrées ou sorties.

La figure suivante montre P0.<0..7> connecté à des signaux d'exemple configurés comme
entrées numériques et sorties numériques. Vous pouvez configurer P1.<0..3> de la même
manière.

Figure 14. Exemple de connexion d'une charge
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 GND
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P0.2
P0.3
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LED

1
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3

4

Signal TTL

NI USB-6008/6009

1. P0.0 configuré comme sortie numérique d'un
collecteur ouvert, qui contrôle une LED

2. P0.2 configuré comme sortie numérique d'un
signal actif, qui contrôle une LED

3. P0.4 configuré comme entrée numérique recevant
un signal TTL à partir d'un inverseur à
déclenchement logique.

4. P0.7 configuré comme entrée numérique recevant
un signal de 0 V ou de 5 V à partir d'un
commutateur

Attention  Le dépassement des spécifications de tension maximale en entrée ou en
sortie peut endommager le périphérique ainsi que l'ordinateur. National Instruments
ne peut être tenu responsable de tout dommage résultant de telles connexions de
signaux. Reportez-vous aux Spécifications du périphérique NI USB-6008 ou aux
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Spécifications du périphérique NI USB-6009 pour obtenir de plus amples
informations.

Informations sur le courant émis/absorbé
La configuration par défaut des ports d'E/S numériques des NI USB-6008/6009 est en mode
collecteur ouvert, ce qui permet des opérations de 5 V, avec une résistance de pull-up
embarquée de 4,7 kΩ. Une résistance de pull-up externe fournie par l'utilisateur peut être
ajoutée pour augmenter le courant source jusqu'à 8,5 mA par ligne, comme l'indique la figure
suivante.4

Figure 15. Exemple de connexion d'une résistance externe fournie par l'utilisateur
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Les ports du NI USB-6009 peuvent aussi être configurés comme signaux actifs en utilisant
l'API NI-DAQmx, ce qui permet des opérations de 3,3 V avec une limite de courant émis/
absorbé de ±8,5 mA. Pour obtenir des informations complémentaires sur la manière de définir
la configuration DIO, reportez-vous au document de la Base de connaissances, How Do I
Configure My NI Device to be Open-Drain (Open Collector) or Push-Pull (Active Drive)?.
Pour accédez à ce document, allez sur ni.com/frinfo et entrez l'info-code ex52p.

Déterminer la valeur de la résistance pull-up fournie par
l'utilisateur
Effectuez les étapes suivantes pour déterminer la valeur de la résistance de pull-up fournie par
l'utilisateur :
1. Placez un ampèremètre en série avec la charge.
2. Placez une résistance variable entre la ligne de sortie numérique et l'alimentation +5 V.

4 Ce document utilise les conventions de noms NI-DAQmx. 'Open-drain' est appelé collecteur ouvert
et 'push-pull' est appelé signal actif.

NI USB-6008/6009 Guide de l'utilisateur | © National Instruments | 21



3. Définissez P0.0 à haut.
4. Ajustez la résistance variable jusqu'à ce que le courant de l'ampèremètre affiche le

courant prévu. Le courant prévu doit être inférieur à 8,5 mA.
5. Supprimez l'ampèremètre et la résistance variable de votre circuit.
6. Mesurez la résistance de la résistance variable. La résistance mesurée est la valeur

optimale de la résistance de pull-up.
7. Sélectionnez une valeur de résistance statique pour votre résistance de pull-up, qui soit

supérieure ou égale à la résistance optimale.
8. Reconnectez le circuit de charge et la résistance de pull-up.

Protection des E/S
Pour protéger les périphériques NI USB-6008/6009 contre les surtensions, les sous-tensions,
les sur-intensités ainsi que les événements ESD, il est préférable d'éviter ces défaillances en
respectant les règles suivantes :
• Si vous configurez une ligne DIO comme sortie, ne la connectez pas à une source de

signal externe, un signal mis à la masse ou un bloc d'alimentation.
• Si vous configurez une ligne DIO comme sortie, il est important de comprendre les

exigences de courant de la charge connectée à ces signaux. Ne dépassez pas les limites de
sortie de courant du périphérique d'acquisition de données.
National Instruments dispose de plusieurs solutions de conditionnement de signaux pour
des applications numériques nécessitant un courant élevé.

• Si vous configurez une ligne DIO comme entrée, ne la faites pas fonctionner avec des
tensions en-dehors de sa gamme de fonctionnement normale. Les lignes DIO ont une
gamme de fonctionnement plus petite que celle des signaux AI.

• Manipulez le périphérique DAQ comme vous le feriez avec tout autre périphérique
sensible à l'électricité statique. Mettez toujours l'équipement à la masse lorsque vous
manipulez votre périphérique d'acquisition de données ou que vous le connectez, et
assurez-vous d'être vous-même relié à la masse.

États au démarrage
Au démarrage et à la réinitialisation du système, le matériel définit toutes les lignes DIO
comme des entrées de haute impédance. Le périphérique DAQ ne positionne pas le signal à un
état haut ou bas. Chaque ligne a une faible résistance de pull-up qui lui est connectée.

DIO statiques
Chacune des lignes DIO des NI USB-6008/6009 peut être utilisée comme ligne d'entrée
numérique (DI) ou de sortie numérique (DO) statique. Vous pouvez utiliser des lignes DIO
statiques pour surveiller et contrôler des signaux numériques. Tous les échantillons de lignes
DI statiques et les mises à jour de lignes DO sont cadencés par logiciel.
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PFI 0
PFI 0 est configurable comme entrée de déclenchement numérique ou comme entrée de
compteur d'événements.

Utilisation de PFI 0 comme déclenchement numérique
Lorsqu'une tâche d'entrée analogique est définie, vous pouvez configurer PFI 0 comme entrée
de déclenchement numérique. Lorsque le déclenchement numérique est activé, la tâche AI
attend un front montant ou descendant sur PFI 0 avant de démarrer l'acquisition. Pour utiliser
le déclenchement de démarrage (ai/StartTrigger) avec une source numérique, spécifiez PFI 0
comme source, puis sélectionnez un front montant ou descendant.

Utilisation de PFI 0 comme compteur d'événements
Vous pouvez configurer PFI 0 comme source de comptage de fronts numériques. Avec ce
mode, les événements de front descendant sont comptés avec un compteur 32 bits. Pour en
savoir plus sur les spécifications de cadencement d'événements, reportez-vous aux documents
Spécifications du périphérique NI USB-6008 et Spécifications du périphérique NI USB-6009 ,
disponibles sur ni.com/manuals.

Référence externe et source d'alimentation
Les périphériques NI USB-6008/6009 créent une référence externe et fournissent une source
d'alimentation. Toutes les tensions sont relatives à la masse (GND).

Référence externe de +2,5 V
Les périphériques NI USB-6008/6009 créent une source de tension de référence à haut degré
de pureté pour le C A/N, en utilisant un régulateur multi-états, un amplificateur et un filtre.
Vous pouvez utiliser la tension de référence de +2,5 V résultante comme signal pour effectuer
un auto-test.

Source d'alimentation de +5 V
Les périphériques NI USB-6008/6009 fournissent une sortie de 5 V, 200 mA. Vous pouvez
utiliser cette source pour alimenter des composants externes.

Remarque  Quand le périphérique est arrêté en USB, la sortie est désactivée.

Et maintenant ?
Cette section dresse la liste des endroits où trouver des exemples de programmes pour les
périphériques NI USB-6008/6009 et toute documentation s'y rapportant.
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Exemples de programmes
Les logiciels NI-DAQmx et NI-DAQmx Base incluent des exemples de programmes pour
vous aider à démarrer la programmation avec les périphériques NI USB-6008/6009. Modifiez
le code d'exemple et enregistrez-le dans une application, utilisez les exemples pour développer
une nouvelle application ou ajoutez le code d' un exemple à une application existante.

NI-DAQmx
Pour trouver les exemples logiciels NI, allez à ni.com/frinfo et entrez l'info-code
daqmxexp.

Pour exécuter des exemples sans matériel installé, utilisez un périphérique simulé NI-DAQmx.
Pour obtenir des informations complémentaires, sélectionnez Aide»Rubriques de l'aide»NI-
DAQmx»Aide MAX pour NI-DAQmx et recherchez "périphériques simulés".

NI-DAQmx Base
Les exemples NI-DAQmx Base sont accessibles à partir de Démarrer»Tous les
programmes»National Instruments»NI-DAQmx Base Examples.

Documentation associée
Tous les ensembles de logiciels d'application et les drivers incluent des informations relatives à
l'écriture d'applications pour la prise de mesures et le contrôle de périphériques de mesure. Les
références aux documents ci-après impliquent que vous avez NI-DAQmx 9.3 ou version
ultérieure, et dans certains cas, la version 8.5 ou version ultérieure des logiciels
d'application NI.

NI USB-6008/6009
Le Guide de démarrage des périphériques NI USB-6008/6009 livré avec les périphériques
NI USB-6008/6009 décrit comment installer le logiciel NI-DAQmx et les périphériques et
comment vous assurer que ces derniers fonctionnent correctement.

Les documents Spécifications du périphérique NI USB-6008 et Spécifications du périphérique
NI USB-6009 contiennent les spécifications des périphériques et sont disponibles sur
ni.com/manuals.

NI-DAQmx
Le fichier Readme NI-DAQmx est disponible à partir du menu Démarrer de Windows et dresse
une liste des logiciels d'application, des périphériques et des ADE supportés par cette version
de NI-DAQmx.

L'Aide NI-DAQmx est disponible à partir du menu Démarrer de Windows et contient une
présentation générale des API, des informations générales relatives aux concepts de mesure,
aux concepts clés NI-DAQmx et aux applications courantes qui sont applicables à tous les
environnements de programmation.
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NI-DAQmx Base (Linux/Mac OS X/LabVIEW PDA 8.x)
Le document Getting Started with NI-DAQmx Base décrit comment installer le logiciel
NI-DAQmx Base, votre périphérique DAQ supporté par NI-DAQmx Base et comment vous
assurer que le périphérique fonctionne correctement sur une machine Windows, Linux ou
Mac. Sous Windows, sélectionnez Démarrer»Tous les programmes»National Instruments»
NI-DAQmx Base»Documentation»Getting Started with NI-DAQmx Base.

Le fichier Readme NI-DAQmx Base dresse une liste des périphériques supportés par les
différentes versions de NI-DAQmx Base. Sous Windows, sélectionnez Démarrer»Tous les
programmes»National Instruments»NI-DAQmx Base»NI-DAQmx Base Readme.

Le fichier NI-DAQmx Base VI Reference Help contient une référence aux VIs et des
informations générales sur les concepts de mesure. Dans LabVIEW, sélectionnez Aide»NI-
DAQmx Base VI Reference Help.

Le document NI-DAQmx Base C Function Reference Help contient une référence aux
fonctions C et des informations générales sur les concepts de mesure. Sous Windows,
sélectionnez Démarrer»Tous les programmes»National Instruments»»NI-DAQmx Base»
Documentation»C Function Reference Help.

Remarque  Toute la documentation NI-DAQmx Base pour Linux est installée
sous /usr/local/natinst/nidaqmxbase/documentation.

Remarque  Toute la documentation NI-DAQmx Base pour Mac OS X est installée
sous /Applications/National Instruments/NI-DAQmx Base/
documentation.

LabVIEW
Reportez-vous à ni.com/gettingstarted pour en savoir plus sur LabVIEW.

Pour accéder aux informations relatives aux concepts de programmation LabVIEW, aux
instructions détaillées pour utiliser LabVIEW ainsi qu'aux informations de référence sur les
VIs LabVIEW, les fonctions, les palettes, les menus et les outils, utilisez l'Aide LabVIEW,
disponible en sélectionnant Aide»Aide LabVIEW dans LabVIEW. Reportez-vous aux
informations suivantes en cliquant sur l'onglet Sommaire de l' Aide LabVIEW pour toute
information relative à NI-DAQmx :
• Référence des VIs et des fonctions »VIs et fonctions d'E/S de mesure »Fonctions et

VIs de DAQmx - Acquisition de données — Décrit les VIs et fonctions LabVIEW NI-
DAQmx.

• Référence des propriétés et des méthodes »Propriétés NI-DAQmx — Contient des
références aux propriétés.

• Prise de mesures — Contient des informations conceptuelles et procédurales dont vous
avez besoin pour acquérir et analyser les données de mesure dans LabVIEW, ce qui inclut
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des mesures courantes, des mesures fondamentales, des concepts clés NI-DAQmx et des
considérations spécifiques aux périphériques.

LabWindows/CVI
La section Data Acquisition du fichier d'aide LabWindows/CVI Help contient la rubrique
Taking an NI-DAQmx Measurement in LabWindows/CVI, qui inclut des instructions détaillées
sur la création d'une tâche de mesure en utilisant l'Assistant DAQ. Dans LabWindows/CVI,
sélectionnez Help»Contents, puis choisissez Using LabWindows/CVI»Data Acquisition.
Ce livre contient également des informations relatives à l'accès à des informations détaillées
via l'Aide NI-DAQmx.

La section NI-DAQmx Library du fichier d'aide LabWindows/CVI Help contient une
présentation et une référence des fonctions d'API pour NI-DAQmx. Sélectionnez Library
Reference»NI-DAQmx Library dans le fichier d'aide LabWindows/CVI Help.

Measurement Studio
Si vous programmez votre périphérique supporté par NI-DAQmx dans Measurement Studio en
utilisant Visual C# ou Visual Basic .NET, vous pouvez, de manière interactive, créer des voies
et des tâches en lançant l'Assistant DAQ à partir de MAX ou de Visual Studio .NET. Vous
pouvez utiliser Measurement Studio pour générer le code de configuration basé sur votre tâche
ou votre voie. Reportez-vous à l'Aide Assistant DAQ pour obtenir de plus amples informations
sur la génération de code.

L'aide NI Measurement Studio Help fait partie intégrante de l'aide de Microsoft Visual Studio.
Pour voir ce fichier d'aide dans Visual Studio .NET, sélectionnez Measurement Studio»NI
Measurement Studio Help. Pour toute information relative au développement avec
NI-DAQmx, reportez-vous aux rubriques suivantes de l'aide NI Measurement Studio Help :
• Pour obtenir des instructions détaillées sur la manière de créer une application NI-

DAQmx en utilisant le Measurement Studio Application Wizard et l'Assistant DAQ,
reportez-vous à Walkthrough: Creating a Measurement Studio NI-DAQmx Application.

• Pour obtenir de l'aide avec les méthodes et les propriétés NI-DAQmx, reportez-vous à
NationalInstruments.DAQmx Namespace et
NationalInstruments.DAQmx.ComponentModel Namespace.

• Pour obtenir de l'aide conceptuelle avec NI-DAQmx, reportez-vous à Using the
Measurement Studio NI-DAQmx .NET Library et Developing with Measurement Studio
NI-DAQmx.

• Pour obtenir de l'aide générale pour la programmation dans Measurement Studio,
reportez-vous à Getting Started with the Measurement Studio Class Libraries.
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Pour créer une application dans Visual Basic .NET ou Visual C#, effectuez les étapes
suivantes :
1. Dans Visual Studio, sélectionnez File»New»Project pour lancer la boîte de dialogue New

Project.
2. Dans le volet Project types, développez le nœud Visual Basic ou Visual C#, selon le

langage dans lequel vous souhaitez créer le projet, puis sélectionnez Measurement
Studio.

3. Choisissez un type de projet. Ajoutez des tâches DAQ dans cette étape.

ANSI C sans logiciel d'application NI
L'Aide NI-DAQmx contient une présentation générale des API ainsi que des informations
générales sur les concepts de mesure. Sélectionnez Démarrer»Tous les programmes»
National Instruments»NI-DAQmx»Aide NI-DAQmx.

La rubrique NI-DAQmx C Reference Help décrit les fonctions de NI-DAQmx Library, que
vous pouvez utiliser avec les périphériques d'acquisition de données National Instruments pour
développer des applications d'instrumentation, d'acquisition et de contrôle. Sélectionnez
Démarrer»Tous les programmes»National Instruments»NI-DAQ»Support de code
textuel»NI-DAQmx C Reference Help.

Langages .NET sans logiciel d'application NI
Avec Microsoft .NET Framework, vous pouvez utiliser NI-DAQmx pour créer des
applications en utilisant Visual C# et Visual Basic .NET sans Measurement Studio. Reportez-
vous au fichier Readme NI-DAQmx pour obtenir la liste des versions supportées.

Cours de formation
Si vous avez besoin de davantage d'aide pour démarrer le développement d'une application
avec des produits NI, NI propose des cours de formation. Pour vous inscrire à un cours ou en
obtenir une description détaillée, reportez-vous à ni.com/training.

Support technique sur le Web
Pour obtenir un support complémentaire, allez sur ni.com/support ou ni.com/
examples.

Remarque  Vous pouvez télécharger ces documents à partir de ni.com/manuals.

De nombreuses spécifications DAQ ainsi que certains guides/manuels sont disponibles au
format PDF. Pour voir les fichiers PDF, Adobe Reader 7.0 ou versions ultérieures (PDF 1.6 ou
version ultérieure) doit être installé. Reportez-vous au site Web d'Adobe Systems Incorporated
à www.adobe.com/fr pour télécharger Adobe Reader. Reportez-vous à la bibliothèque des
manuels des produits National Instruments à ni.com/manuals pour consulter les ressources
de documentation les plus récentes.

NI USB-6008/6009 Guide de l'utilisateur | © National Instruments | 27



Support et services dans le monde
Le site Web de National Instruments est une source complète de support technique. Sur 
ni.com/support, vous pouvez accéder à toutes les ressources de support technique disponibles,
qu'il s'agisse d'un dépannage, de ressources d'auto-assistance technique pour le développement
d'applications ou d'une assistance technique fournie par les ingénieurs d'application NI par
téléphone ou e-mail.

Visitez ni.com/services/f pour vous procurer des services d'installation en usine (NI Factory
Installation Services), des réparations, une extension de la garantie, et des services
d'étalonnage ou autres.

Visitez ni.com/register pour enregistrer votre produit National Instruments. L'enregistrement
de vos produits vous permet d'utiliser plus facilement le support technique et de garantir que
vous recevrez les mises à jour importantes de NI.

Une déclaration de conformité, ou DoC, est notre déclaration de conformité avec le Conseil de
l'Union européenne ; celle-ci s'appuie sur la déclaration de conformité du fabricant. Ce
système confère à l'utilisateur une protection en matière de compatibilité électromagnétique
(CEM) et de sécurité des produits. Vous pouvez obtenir la déclaration de conformité pour votre
produit en visitant le site ni.com/certification. Si votre produit supporte l'étalonnage, vous
pouvez obtenir le certificat d'étalonnage relatif à votre produit sur ni.com/calibration.

Le siège social de National Instruments est situé à l'adresse suivante :
11500 North Mopac Expressway, Austin, Texas, 78759-3504, USA. National Instruments
compte aussi des filiales dans le monde entier. Pour obtenir le support téléphonique aux États-
Unis, créez votre requête de service sur ni.com/support ou composez le
1 866 ASK MYNI(275 6964). Pour obtenir du support téléphonique en-dehors des États-Unis,
visitez la page des filiales internationales sur ni.com/niglobal afin d'accéder au site Web de
votre filiale. Vous y trouverez les informations les plus à jour pour contacter le support
technique par téléphone ou e-mail, ainsi que le calendrier des événements.

Reportez-vous à NI Trademarks and Logo Guidelines sur ni.com/trademarks pour obtenir des informations concernant les
marques de National Instruments. Les autres noms de produits et de sociétés mentionnés aux présentes sont les marques ou
les noms de leurs propriétaires respectifs. Pour la liste des brevets protégeant les produits/technologies National Instruments,
veuillez vous référer, selon le cas : à la rubrique Aide»Brevets de votre logiciel, au fichier patents.txt sur votre média, ou à
National Instruments Patent Notice sur ni.com/patents. Vous trouverez des informations sur les contrats de licence utilisateur
final (CLUF) et les notices juridiques de tiers dans le fichier Readme de votre produit NI. Reportez-vous à la page Export
Compliance Information sur ni.com/legal/export-compliance pour consulter la politique de National Instruments en matière
de conformité à la réglementation gouvernant le commerce international et pour savoir comment obtenir les codes de tarif
douanier (HTS) et les numéros ECCN pertinents, ainsi que d'autres données relatives à l'import-export. NATIONAL
INSTRUMENTS NE DONNE AUCUNE GARANTIE, EXPLICITE OU IMPLICITE, QUANT À L'EXACTITUDE DES
INFORMATIONS CONTENUES AUX PRÉSENTES ET NE SERA PAS RESPONSABLE DES ERREURS. Entités
gouvernementales américaines : Les données contenues dans ce manuel ont été développées à l'aide de fonds privés et sont
sujettes aux droits limités et aux droits restreints sur les données applicables, énoncés dans les sections FAR 52.227-14, DFAR
252.227-7014 et DFAR 252.227-7015.

© 2004—2015 National Instruments. Tous droits réservés.
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